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Preface

This guide provides reference information about the parameters in the Thermo Scientific 
Deconvolution Plugin application within Thermo Scientific™ TraceFinder™ software for gas 
chromatography (GC) and mass spectrometry (MS) instruments. The Deconvolution Plugin 
can be used with the following GC-MS systems:

• Thermo Scientific™ Q Exactive™ GC Mass Spectrometer

• Thermo Scientific™ ISQ™ LT Mass Spectrometer

• Thermo Scientific™ TSQ™ 8000 Evo Mass Spectrometer

Related Documentation
The Deconvolution Plugin application includes complete documentation. In addition to this 
guide, you can also access the following documents as PDF files from the data system 
computer:

If you have a Q Exactive GC mass spectrometer, the manuals on your data system are:

• Q Exactive GC Preinstallation Requirements Guide: PN 1R120706-0001

• Q Exactive GC Operating Manual: PN 1R120706-0002

• Q Exactive GC Software Manual: PN 1R120706-0003

• Q Exactive GC Quick Start Guide: PN 1R120706-0004 

 To view the product manuals

Go to Start > Programs > Thermo Exactive Series > Manuals.

Contents

• Related Documentation

• System Requirements

• Cautions and Special Notices

• Contacting Us
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If you have a TSQ 8000 Evo mass spectrometer, the manuals on your data system are:

• TSQ 8000 Evo Preinstallation Requirements Guide: PN 1R120568-000 

• TSQ 8000 Evo User Guide: PN 1R120568-0002 

• TSQ 8000 Evo Hardware Manual: PN 1R120568-0003

• TSQ 8000 Evo Spare Parts Guide: PN 1R120568-0004

• TSQ 8000 Evo AutoSRM User Guide: PN 1R120568-0005

 To view the product manuals

Open the Manuals folder on your desktop.

If you have an ISQ LT mass spectrometer, the manuals on your data system are:

• ISQ Series Preinstallation Requirements Guide: PN 1R120555-0001

• ISQ Series Hardware Manual: PN 1R120555-0002

• ISQ Series User Guide: PN 1R120555-0003

• ISQ Series Spare Parts Guide: PN!r120555-0004

 To view the product manuals

Open the Manuals folder on your desktop.

 To open Help

• From the Deconvolution window with the TraceFinder software application, choose 
Help.

For access to the application Help, follow this procedure. 

 To view application-specific Help

• From the application window, choose Help > Deconvolution Plugin Help.

• If information about setting parameters is available for a specific view, page, or dialog 
box, click Help or press the F1 key for information about setting parameters.

• In applications that have a Communicator bar, click the field or parameter to display 
definitions, required actions, ranges, defaults, and warnings.

For more information, visit www.thermoscientific.com.

http://www.thermoscientific.com
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System Requirements
The Deconvolution Plugin application requires a license. In addition, ensure that the system 
meets these minimum requirements.

Cautions and Special Notices
Make sure you follow the cautions and special notices presented in this guide. Cautions and 
special notices appear in boxes; those concerning safety or possible system damage also have 
corresponding caution symbols.

This guide uses the following types of cautions and special notices.

IMPORTANT  Before you install the device driver, ensure that the data system computer 
has a compatible version of the Thermo Foundation™ platform and instrument control 
software as noted in the Deconvolution Plugin 1.1 Release Notes.

System Minimum requirements

Computer • 4.6 GHz processor with 16 GB RAM

• CD/R-Rom or DVD drive

• 1000 GB or hard drive

• Video card and monitor capable of 1680 1050 resolution

• Quad core processor

Software • Adobe™ Reader™ 10

• Microsoft™ Windows™ 7 SP1 (64-bit)

• Thermo Foundation™ 3.1 SP1

• Thermo Scientific™ Xcalibur™ 4.0

• TraceFinder 4.0

• Instrument Control Softwarea

– GC Devices 3.2 or later

– Exactive Series 2.7 or later (Q Exactive GC systems)

– TSQ Series 3.2 or later (TSQ 8000 Evo systems)

– ISQ Series 3.2 or later (ISQ LT systems)
a Check latest release notes for version compatibility.
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Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

 To find out more about our products 

Go to www.thermoscientific.com/en/products/mass-spectrometry.html for information 
about our products.

 To get local contact information for sales or service

Go to www.thermoscientific.com/en/support-landing/support.html.

 To suggest changes to documentation or to Help

• Fill out a reader survey online at www.surveymonkey.com/s/PQM6P62 or send an 
e-mail message to the Technical Publications Editor at 
techpubs-austin@thermofisher.com.

CAUTION  Highlights hazards to humans, property, or the environment. Each CAUTION 
notice is accompanied by an appropriate CAUTION symbol.

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.

http://www.surveymonkey.com/s/PQM6P62
http://www.thermoscientific.com/en/products/mass-spectrometry.html
http://www.thermoscientific.com/en/support-landing/support.html
mailto:techpubs-austin@thermofisher.com
mailto:techpubs-austin@thermofisher.com
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Deconvolution Plugin Application

This chapter contains set-up information about, detailed descriptions of the functions, and a 
sample workflow for the Deconvolution Plugin application for TraceFinder software.

Setting Up the Deconvolution Plugin
 To set up the Deconvolution Plugin

1. First, ensure the TraceFinder 4.0 software and the Deconvolution Plugin application are 
installed. If not, follow the instructions in the release notes or installation help files to 
install the programs.

2. Click the TraceFinder 4.0 Administration Console icon on your desktop. The 
Administrator Console opens.

3. In the Administrator Console, double-click Administration under Plugins. See Figure 1.

Contents

• Setting Up the Deconvolution Plugin

• Functional Description

• Workflow

Note  If you have enabled security, an administrator must log in to the TraceFinder 
Administrator Console before modifying plugin settings. 
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Figure 1. Configuring the Plugin Using the TraceFinder 4.0 Administrator Console

4. Check the box labeled Thermo.Deconvolution and click Apply to enable the 
Deconvolution Plugin application. See Figure 2.

Figure 2. Enabling the Deconvolution Plugin

5. Restart the TraceFinder application to view the plugin.
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Functional Description
This section contains descriptions of the functions of the Deconvolution Plugin application 
for TraceFinder software. 

Sample View

The sample view of the Deconvolution Plugin application contains the following sections:

• Sample List

• Peak List

• Peak Identification

• Total Ion Chromatogram

• Extracted Ions

• Spectra

Figure 3 shows the Sample View of the Deconvolution Plugin application. 

Figure 3. Deconvolution Plugin Sample View

IMPORTANT  If you want to use TraceFinder software itself to process data by unknown 
screening, you must uninstall the Deconvolution plug or your analysis will return no 
results. To uninstall the plugin, deselect Thermo.Deconvolution in the TraceFinder 
Administrator Console and restart the TraceFinder application.
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Sample List

The Sample List window displays the names and identifying information of the samples in the 
batch. To switch between samples in a batch, click on the sample in the table. See Figure 4.

Figure 4. Sample List Window

Peak List

The Peak List window allows users to switch between chromatographic peaks which have 
been detected. The peak sets are named by the compound selected by the user in the Matched 
Compounds in the Peak Identification list. The peak list also lists retention times and 
summed ion intensities. See Figure 5.

Figure 5. Peak List Window

Peak Identification

Figure 6. Peak Identification Window

The Peak Identification window uses the following criteria to identify compounds.

Export to 
NIST Icon
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• Matched Compound — The primary name of a compound in the selected library.

• Library Hit Name — Alternate names for a compound that appear in the selected 
library.

• Formula — The compound formula for each detected peak.

• CAS Number — The CAS number for each compound detected.

• SI — The search index score (0-999) for each compound detected returned by the NIST 
library search.

• HRF (High-Resolution Filtering) Score — The percentage of the total ion 
chromatogram of the spectrum that can be explained by the chemical formula in the 
library search. A complete set of theoretical ions which could result from the chemical 
formula is generated from all non-repeating combinations of atoms. A simple example is 
the chemical formula C2H2, which could produce the ions H+, H2+, C+, CH+, CH2+, 
C2+, C2H+, and C2H2+. Each peak in the deconvolved experimental spectrum is 
checked to see if it is within the set mass tolerance of one of these possible ions from the 
original chemical formula. The intensity of the ions which match at least one possible ion 
from the original chemical formula is divided by the total ion current of the deconvolved 
experimental spectrum to give the HRF Score.

• M+ m/z —The mass-to-charge of the molecular ion.

• Score — Combined score (0-100) indicating quality of match between this library hit 
and the deconvolved experimental spectrum. It combines several metrics including SI and 
HRF Score.

• M+ — This value is set to Yes if the molecular ion is detected in the deconvolved 
experimental spectrum. See the Extracted Ion View.

• M+ Lib — The value is set to Yes if the NIST spectrum has an ion at a m/z consistent 
with the molecular (M+) ion.

• % Elements — This value is the percent of all the elements in the library hit formula that 
are found in at least one theoretical ion from the chemical formula assigned to a m/z in 
the deconvolved experimental spectrum.

• Library — The name of the database used for the compound identification.

You can also switch between compound matches for a selected chromatographic peak set and 
select the correct compound ID. If you want to select a different compound than the one 
selected, right-click and choose Select Library Hit. If you want to deselect a 
compound—normally done if none of the listed compounds is the correct 
identification—highlight it in the list, right-click and choose Deselect Library Hit. Peaks 
without a selected library hit are named “Peak@x.xxx min.” Library searches can be done on 
all or selected compounds. Users can export the accurate-mass deconvoluted spectra from the 
acquired compound to a .msp file that can be imported into the NIST MS Search program by 
clicking the Export to NIST Library Icon. See Figure 6. For instructions on exporting 
deconvolved spectra to the NIST Library, go to Exporting Library Hits to the NIST Library.
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Total Ion Chromatogram 

The Total Ion Chromatogram window displays a plot of the total ion chromatogram (TIC). 
Users may zoom in and out on chromatographic peaks. To view the TIC, select View >Total 
Ion Chromatogram from the top menu of the Deconvolution application. The selected 
chromatographic peak is highlighted. Users can select the active peak set by clicking on the 
marks in the TIC. The extracted ions for the selected binned peak set should be visualized at 
its retention time. See Figure 7.

Figure 7. Total Ion Chromatogram Window

Extracted Ions

The Extracted Ions window displays an overlay of the extracted ion chromatogram peak set. It 
contains a list of ions found in the deconvolved experimental spectrum.The selected mass is 
always highlighted, and users can select different masses using this window. To select 
individual masses, click on the ion trace of interest in the window or click one of the rows in 
the table. See Figure 8.

The selected ion is also highlighted in the Spectra window. See Figure 9.

Figure 8. Extracted Ions Window

The mass list for the selected peak is displayed underneath the Extracted Ions window. The 
mass list has the following elements:

Active Ion Trace 
(in Red)

Active Ion Trace 
(Selected in Table)

Reprocess Library
Search Icon
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• Active — Lists whether or not the mass is active in the spectrum. All masses in the 
spectrum are defaulted to active. 

• Measured m/z — The measured mass-to-charge ratio of the active mass.

• Area — This refers to the area under a peak for the measured m/z.

• Height — This refers to the peak height for the measured m/z.

• Fragment ID — The predicted fragment formula with the smallest mass error. If there is 
more than one fragment that could match the measured m/z, right-click and choose Show 
All Fragments For Mass to view the list of all possible fragments.

• Fragment Count — This parameter refers to the number of theoretical fragments of the 
library search formula that fall within the set mass tolerance of the experimentally 
measured m/z. If this value is ≥1, we say this m/z is “explained” by the formula from the 
library hit. All ions with ≥1 fragment count are used to calculate the HRF Score. 

• M+ — (To view this parameter, click the magnifying glass in the Extracted Ions top 
menu) This value is set to True if this ion is within the set mass tolerance of the 
theoretical M+ of the chemical formula returned by the library search. This value is also 
set to True if no theoretical ion matches this ion. The M+ Yes/No in the Peak 
Identification View is not set to Yes unless an M+ was actually found in the spectrum.

• Theoretical m/z — The mass-to-charge ratio as calculated from each Fragment ID.

• Mass Error (ppm) — The relative mass error for the measured m/z relative to the 
theoretical m/z.

Spectra

The Spectra window displays the acquired deconvoluted spectra with mass precision to six 
decimal places for high-resolution date (two decimal places for unit-mass data) along with the 
currently selected library spectrum for comparison. The selected mass is highlighted. Users 
can select different masses in this window. Clicking on a mass peak shows the exact mass as 
well as the formula for the closest matching fragment. See Figure 9.

Note  Users can deactivate ions by removing the check from the Active box. Reprocessing 
the library search removes inactive ions from the spectrum.

Note  If fragment annotation was not selected in the processing parameter window when 
the batch was processed, right click within the mass list table and select Annotate 
Spectrum to identify the ions within the selected compound's spectrum.

Note  To view all fragments for ions with ≥1 fragment count, right-click on the ion in the 
Fragment Count list and select Show Other Fragments for Mass.
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Figure 9. Spectra Window

Workflow
The information below provides a sample workflow for the Deconvolution Plugin software. 
The workflow described here consists of the following sections:

• Acquiring Data

• Processing the Data

• Filtering Processed Data and Removing Unwanted Peaks

• Cross-Sample Compound Alignment (Optional)

• Exporting Library Hits to the NIST Library

• Importing Results into TraceFinder Software

• Creating a Report

For additional information, refer to the TraceFinder software user manuals or your mass 
spectrometer’s user guide or software manual.

Acquiring Data

The first step in your workflow is to acquire data in the TraceFinder software application.

 To acquire data in TraceFinder software

1. First, go to Method Development in TraceFinder and create an unknown screening 
master method. See the TraceFinder software user documentation for instructions.

2. Create a batch in the TraceFinder application. Select File > New > Batch. See Figure 10. 
You may also use the acquisition wizard in TraceFinder to acquire your batch.

Note  It is recommended that you deselect Alignment and Gap Filling when setting up 
your TraceFinder software Master Method. This turns off the With RT Alignment 
processing function when submitting a batch for acquisition in TraceFinder software.
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Figure 10. Creating a Batch

3. The Create New Batch window opens. Name the batch, set Type to Unknown Only and 
select the master method you created in step 1 for your sequence. See Figure 11.

Note  The Deconvolution Plugin application can only process full-scan MS scan filters, 
and only one scan filter per raw file. Use the guidelines below to determine if the 
application can process your raw file. 

If you only want to peak detect and library search a raw file, and you have: 

• A raw file with two full-scan MS filters that are identical except that one is a lock 
mass, the application uses the scan filter without the lock mass to process the raw file.

• A raw file with more than one non-identical full-scan MS filter, the application does 
not process the raw file and displays an error message.

• One full-scan MS filter (plus an optional matching lock mass filter) and a SIM, MSX, 
PRM or other type of scan filter, the application uses only the full-scan MS filter 
without the lock mass to process the raw file.

If you want to retention time align multiple files, all the raw files in your batch must meet 
the above criteria and have identical full-scan MS filters.
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Figure 11. Naming a Batch

4. Set up your sample list and click the acquire sample icon to acquire your samples. See 
Figure 12.

Figure 12. Acquiring Samples

Acquire Sample 
Icon Group Names
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Processing the Data

Functional descriptions of the processing parameters and the workflow for processing data in 
Deconvolution Plugin application can be found in the following sections:

• Functional Description of Processing Parameters

• Data Processing Workflow

Functional Description of Processing Parameters

 To access the processing parameters in the Deconvolution Plugin application

1. Click the processing icon in the Peak List window. See Figure 13.

Figure 13. Locating the Processing Icon in the Peak List Window

2. The Processing Parameters window opens. See Figure 14.

Note  If you already have acquired raw files and want to associated them with this batch, 
you may browse them in by double-clicking on a cell under Filename and choosing the 
raw file or files.

Note  Name groups in the sequence and the application will use those groups to calculate 
fold changes and cv’s. If you name a group “control,” the software will use that as the basis 
with which to calculate the fold change. Samples with the same group name will be placed 
in the same group.

Processing Icon
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Figure 14. Viewing the Processing Parameters

3. Descriptions of available processing settings and how best to use them are below.

• Accurate Mass Tolerance (+-) — Enter the accurate mass tolerance that the software 
uses throughout the program.

• m/z SigToNoise Threshold — Enter the signal-to-noise threshold that the software 
uses to determine whether to include ions in each compound’s deconvolved spectra.

• TIC Intensity Threshold — Enter the TIC intensity threshold that the software uses 
to determine whether to include compounds in the compound peak list. The TIC 
intensity is the summed intensity of all ions in a compound’s spectra after passing 
through the deconvolution processing step.
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• Ion Overlap Window — Enter the peak height at which the software creates a 
retention time window around each compound’s base peak in order to determine 
whether other closely eluting ions are grouped with this compound during the 
deconvolution process. If a lower intensity ion falls within this retention time 
window, and all other criteria is met (e.g. signal to noise threshold) it is grouped 
together with the base peak and other ions meeting this criteria to create the 
compound’s deconvolved spectra. The higher the ion overlap window percentage, the 
less likely ions generated from two compounds are grouped within the same 
spectrum.

• RT Aligning — Enter the retention time window that the software uses to look for a 
compound detected in one sample in all other samples during the retention time 
alignment process. 

• Library Search Type — Select Normal or HiRes from the Library Search Type 
drop-down menu. If the method uses an accurate mass library, select HiRes. If the 
method uses a unit resolution library select Normal. 

• Libraries — Choose the library or libraries you want to use, adjust the other settings 
as desired, and click Save. The available libraries depend on those installed on your 
system.

• SI (RSI) — Enter the search index threshold that the software uses to determine 
whether to include a library hit in the Peak Identifications list. If a compound has 
no library hits above the entered threshold, it is still displayed in the Peak List as an 
unidentified peak. If it is desired to use the reverse search index rather than the search 
index, select the Reverse Search box. 

• Penalize Missing Molecular Ion — Check this box if it you wish to award extra 
points to a library hit’s total score when the spectrum contains a molecular ion that 
matches the library hit’s molecular formula within the set accurate mass tolerance. If 
this check box is not selected, all library hits will receive the points awarded for 
having the molecular ion of the library hit present in the spectrum.

• Annotate Fragments — Check this box if you wish to annotate fragments of each 
identified compound during the library search processing step. This adds additional 
processing time. Identified compounds can be annotated individually after processing 
by right-clicking in the table at the bottom of the Extracted Ion Window (see 
Figure 8) and selecting Annotate Spectrum. 

Data Processing Workflow

 To process your data in the Deconvolution Plugin application

1. Click Open Deconvolution Plugin on the top menu of the TraceFinder application or 
click the Deconvolution Plugin tab along the side menu. See Figure 15.
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Figure 15. Opening the Deconvolution Unknowns Plugin 

2. (Optional) Click the pin icon on the Analysis tab to hide the side menu for better 
viewing. See Figure 16.

3. Click the Refresh Sample List button to synchronize your sample list with the Batch 
View. See Figure 16.
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Figure 16. Hiding the Side Menu and Refreshing the Sample List

4. Click the settings icon to adjust the plugin settings. See Figure 17.

Figure 17. Locating the Settings Icon

Note  For detailed descriptions of the processing settings, review the Functional 
Description of Processing Parameters.

Refresh Sample List
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5. The Settings dialog box opens. See Figure 18.

Figure 18. Changing the Settings

6. Select Normal or HiRes from the Library Search Type drop-down menu. If using an 
accurate mass library, select HiRes. If using a unit resolution library select Normal. See 
Figure 19.

Figure 19. Selecting the Library Type

Note  You must have NIST 2014 and at least one NIST-formatted library installed on 
your system. 
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7. Choose the library or libraries you want to use, adjust the other settings as desired and 
click Save. The available libraries depend on those installed on your system. 

8. In the Peak List box, select whether you want the application to do peak detection or 
peak detection and library search, and choose if you want to apply the settings to the 
current sample, the unprocessed samples, or all the samples in your list. For this example, 
we will select Peak Detection and Library Search applied to All Samples. See Figure 20.

Figure 20. Selecting the Peak Detection Settings

9. The plugin starts processing all the samples. The green status bars indicate the software is 
processing your samples. This may take a significant amount of time if you have a large 
number of samples or very large raw files. See Figure 21.

Note  The Deconvolution Plugin application uses a lot of computer resources to process 
data as quickly as possible. Processing results during acquisition can interfere with raw file 
acquisition. Wait to process raw files until acquisition is complete or use separate 
computers to acquire and to process data. Closing all other applications on the PC where 
you are processing data will improve processing speed.
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Figure 21. Processing the Samples

Filtering Processed Data and Removing Unwanted Peaks

This section describes how to apply filters to processed data and remove unwanted spectra 
from processed data. The workflow contains the following two subsections.

• Filtering Processed Data

• Removing Unwanted Peaks

Filtering Processed Data

This section describes how to apply filters to processed data.

 To set a compound filter

1. Click the compound filter icon. See Figure 22.

Note  You cannot use TraceFinder software while processing data in the Deconvolution 
Plugin application.
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Figure 22. Setting a Compound Filter

2. The compound filter allows you to display only those compounds with a feature that you 
are interested in. For example, as shown in Figure 23 below, the peak list can be filtered to 
show only compounds with a deconvoluted spectra that contains a chlorine ion or 
common chlorine fragments. Similarly, chlorine containing compounds can be filtered by 
using the delta mass filter to pull out spectra that contain two mass differing by the mass 
difference between Cl37 and Cl35 isotopes. 

Figure 23. Filtering Chlorine Compounds

3. When this filter is turned on, the number of peaks is reduced from 235 to 29. See 
Figure 24.

Compound 
Filter Icon
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Figure 24. Peak Number Reduced after Filtering

The following describes the various types of filtering that can be applied to a data set:

• Min TIC Intensity — Enter the TIC intensity threshold the software will use to 
filter compounds in the compound peak list.

• Use RT Range — Enter the minimum and/or maximum retention time the software 
will display compounds in the compound peak list.

• Use Mass Filter — Select if filtering by a mass or mass delta is desired.

– Spectra Contains Mass — Select to filter peak list to only display peaks that 
contain a certain mass or masses. If any of the masses in the mass filter are 
contained within a compound’s spectrum, the compound will be displayed. 

– Spectra Contains Mass Delta — Select to filter peak list to only display peaks 
that contain a certain delta mass or delta masses. If any two ions within a 
compound’s spectrum have a difference in mass that meets any of the delta 
masses in the delta mass filter, the compound will be displayed. 

For both types of mass filters, a calculator is provided for calculating the exact mass of 
the ion or delta mass. Example inputs for decane and its 13C isotope are shown below 
to demonstrate the format required for formula input:

– For decane (C10H12), the input into the calculator should be as follows: 
C10H22

– For the 13C isotope of decane (C9
13CH22), the input into the calculator 

should be as follows (note the space required before and after the 13C 
isotope): C9 C(13) H22.
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Figure 25 demonstrates how the mass delta calculator calculates the mass difference 
of the two major chlorine isotopes that were used in the filter shown in Figure 23.

Figure 25. Using the Mass Delta Calculator

• Only Show Peaks with Library Hits — Select to filter the compound list only on 
those compounds which have identifications associated with them. Additional 
filtering based on total score, (R)HRF score, and R(SI) thresholds can be set. 

Further filtering based on the identified compound’s formula, CAS number, matched 
compound name, library hit name, or synonym list names can be applied.

Library hit filters apply to the peak list only and depend on whether any of the peak's 
associated library hits meet the specified criteria. For example, if no library hits for a 
compound meet the search index threshold, then the compound does not appear in 
the peak list. If one or more library hits for a compound meet the threshold, the 
compound appears in the peak list, and all of its library hits appear regardless of 
whether they meet the threshold. 

Removing Unwanted Peaks

 To remove unwanted peaks from processed data

1. Click the Remove Peaks icon from the Peak List. See Figure 26.

Note  If a sample has been processed using Reverse Search, then the threshold 
values entered for the (R)HRF and (R)SI apply to the reverse search score for these 
parameters. Otherwise these threshold values apply to the forward search values. 



Figure 26. Locating the Remove Peaks Icon

2. To remove the selected compound, select Remove Current Peak.

3. If a filter is applied, select Remove All Peaks Not Matching Current Filter. After selecting this, 
compounds that have been removed by the applied filter do not reappear when the filter is 
removed. This action can be performed on the selected sample, or on all samples in the batch.

4. To reverse actions to remove peaks, select Restore All Peaks. This action can be performed on the 
selected sample, or on all samples in the batch.

Cross-Sample Compound Alignment (Optional)

After your data are processed, you can group compounds across the batch with similar spectra and 
retention times if required for your analysis. This is useful if you want to compare the response of 
compounds across samples in the batch. Once they are aligned, all the samples have the same list of 
compounds, which makes it easy to compare them. See Figure 42.

 To align the compounds by retention times

1. In the Sample List in Sample View, check samples as Inclusion or Exclusion samples as shown in 
Figure 27. Inclusion and exclusion samples will be explained in the following sections.

Remove Peaks 
Icon
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Figure 27. Setting Samples to Inclusion or Exclusion

2. Select View > RT Alignment View. See Figure 28.

Figure 28. Opening the RT Alignment View

3. As shown in Figure 29, click the processing icon. Under RT Align Peaks select either All, 
Inclusion, Exclusion or Modified Inclusion. These selections are explained below:

• All — Selecting All will look for all peaks detected in each processed sample in all other 
processed samples.

• Inclusion — Selecting Inclusion will look for only those compounds detected in samples 
marked inclusion samples in all other processed samples. 

• Exclusion — Selecting Exclusion will look for all peaks detected in each processed sample 
except for those peaks also found in samples that are marked exclusion samples. An example of 
a sample type you might want to mark as an exclusion sample is a solvent blank, so that all 
peaks found in the solvent blank are removed from the batch’s cross sample peak table.

• Modified Inclusion — Selecting Modified Inclusion will RT align those compounds 
detected in samples marked inclusion samples, except for those compounds also detected in 
exclusion samples. 
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Figure 29. Aligning Compounds by Retention Times

4. The Deconvolution Plugin Processing window opens. The green bars show the status of the RT 
alignment process. See Figure 30.

Figure 30. Aligning Compounds in Batch by Retention Times

5. The compounds are now aligned by retention times. See Figure 31.

Note  This step might take a significant amount of time depending on the batch size. 
Large numbers of files with many compounds also consume a lot of memory. You might 
need to break a large batch into several smaller batches.
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Figure 31. Compounds Aligned by Retention Times

Exporting Library Hits to the NIST Library

This section contains instructions for exporting the accurate-mass deconvoluted spectra from an 
acquired compound to a .msp file for import into the NIST MS Search program.

 To export library hits to the NIST Library

1. From the Peak Identification window in Sample View, click the Export to NIST Library icon. 
See Figure 32.

Note  RT Alignment View contains similar information to Sample View, with the addition of 
displaying Peak Areas of compounds across samples in the batch. It also contains the Average Score 
of a compound, which is the weighted average by intensity of a compound’s match score across the 
batch. See Figure 31.

Note  Once compounds are aligned by retention time, certain features of the plugin are no 
longer available. This is because each sample is no longer independent, and changing one 
affects the entire batch.To use the disabled features, you must first clear RT alignment. See 
Figure 31. Clearing RT alignment returns the batch to its state prior to RT alignment 
processing.

Clear RT 
Alignment Icon

Average Score
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Figure 32. Locating the Export to NIST Library Icon

2. Select either Without Annotations to export spectra without additional comments, or With 
Annotations to add additional information to the spectrum export.

3. If With Annotations is selected, the Annotations Editor window appears. See Figure 33

Figure 33. Viewing the Annotations Editor

4. You can enter text annotations under General, Sample, and Library Comments. The plugin 
remembers annotations entered under General for all future spectrum exporting and those entered 
under Sample for future spectrum exporting for the selected sample. The plugin remembers 

Export to NIST 
Icon
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annotations entered under Library Comments only when exporting the spectrum from the 
selected compound.

5. You can annotate spectra in custom fields or the general text field available in NIST formatted 
spectra. In order to correctly visualize custom fields imported into the NIST MS Search program, 
perform the following procedure.

6. After entering the Custom Field Names, click the Copy Custom Fields to Clipboard button in the 
top left corner. See Figure 34.

Figure 34. Copying Custom Fields to the Annotations Clipboard

7. In the NIST MS Search program, open the Comment Field Options. See Figure 35.

Figure 35. Opening the Comment Field Options

8. Overwrite the existing text with the comment fields copied to the clipboard. See Figure 36. Now 
the NIST MS Search program recognizes these fields as custom fields when importing spectra.

Copy Custom 
Fields to 
Clipboard Icon
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Figure 36. Overwriting Existing Text with Comments

9. Follow the procedure for importing the .msp file that was exported from the deconvolution 
plugin, as described in the NIST MS Search help.

10. Your custom fields should now appear in the imported spectra. See Figure 37.

Figure 37. Viewing Custom Fields in Imported Spectra

Importing Results into TraceFinder Software

 To import results into the TraceFinder software application

1. First, process all the samples in the Deconvolution Plugin application. See Processing the Data.

2. The Deconvolution Plugin application allows users to set the mass tolerance for high-resolution 
Orbitrap data and uses a mass tolerance of 500 mmu for unit resolution nominal mass data. You 
must change the mass tolerance in the Master Method in TraceFinder software. Go to Analysis > 
Local Method > Processing to change the mass tolerance. See Figure 38.
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Figure 38. Setting the Mass Tolerance

3. Ensure that under Search Options, only Library Search is selected. Other search options aren’t 
supported in this version of the plugin.

Note  The default number of library matches in the TraceFinder application is three, 
which might not be enough for your needs. To increase the number of library matches, 
before running samples, open the Analysis panel in the TraceFinder application, and go 
to Processing > Peak Settings. Change the Number of Top Library Matches to the 
number you would like TraceFinder to keep. 

Mass Tolerance
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Figure 39. Setting the Search Options

4. Next, under Local Method in the side menu of TraceFinder software, click Peak Detection 
Settings and change the Detection Algorithm to Avalon. Next, change the Detection Method to 
Nearest RT.   TraceFinder software peak detects based on the RT and m/z reported by the plugin. 
To accurately pick the correct peak in a busy chromatogram, TraceFinder software must be set for 
Nearest RT rather than Highest Peak. Otherwise, TraceFinder software may find a neighboring 
isomer or other similar peak if it is bigger than the real peak. Also, it’s recommended to set Avalon 
parameters as seen in Figure 40 so they closely match the peak detection settings used in the 
plugin. 

Note  Setting the peak detection settings to Avalon, Nearest RT, smoothing to 9, and mass 
tolerance to the same value set in the Deconvolution Plugin application processing 
settings makes the area and height results in TraceFinder software and the plugin more 
consistent. There still might be differences in the results. 

Library Search Only Checked
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Figure 40. Changing the Detection Method in TraceFinder

5. Go to Batch View on the left side menu in TraceFinder software.

6. Click the Submit Batch icon to import the samples into TraceFinder. See Figure 41.

7. The Submit Options dialog box opens. See Figure 41. Submit the batch for processing with 
Unknown Screening settings selected within TraceFinder software so that they match the 
processing in the Deconvolution Plugin application. The allowed setting combinations are:

• If only peak detection was applied to samples in the plugin, select only Peak Detect in 
TraceFinder software.

• If peak detection and library search were applied to samples in the plugin, select Peak Detect 
and Identify in TraceFinder software.

• If peak detection, library search, and RT alignment were applied to samples in the plugin, 
select Peak Detect, Identify, and With RT Alignment in TraceFinder software.

• If peak detection and RT alignment were applied to samples in the plugin, select Peak Detect 
and With RT Alignment in TraceFinder software.

No other combinations are allowed. 

Note  TraceFinder software only allows one mass tolerance to be applied to a batch.
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Figure 41. Setting Submit Options 

8. The results appear in the TraceFinder unknowns view. See Figure 42.

Figure 42. Viewing the Results in the TraceFinder Unknowns View

Note  TraceFinder software uses retention time and base peak mass provided by the plugin 
application to peak detect compounds displayed in Unknown Screening View. For this 
reason, it might take a significant amount of time to import compounds into the 
TraceFinder Unknown Screening View.

Submit Batch 
Icon
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9. Use the View menu in TraceFinder data review to choose what parameters you want to see on 
screen for your data review.

Figure 43. Selecting Data Review Parameters in TraceFinder Software

Creating a Report

After you have viewed the results of your analysis in TraceFinder software, you can export the data for 
further analysis; for example, into a statistical software package. The Deconvolution Plugin application 
supplies a sample report template for creating cross sample peak tables in a format that you can import 
into these applications. These templates are installed automatically with the plugin.

 To create a report using an installed template

1. Check the compounds you want to export in the Selected column in the Cross Sample Peak List 
tab in the TraceFinder Unknown View. No compounds are checked by default. See Figure 44.

Note  For detailed information on using TraceFinder Unknowns View, see the TraceFinder user 
documentation or Help.

Note  This step only applies if you are using one of the Cross Sample Peak Table Report templates.
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Figure 44. Checking Compounds to Export in TraceFinder Unknowns View

2. In TraceFinder software, go to Analysis > Report View > Local Method > Reports.

3. The Report View page opens. See Figure 45.

Figure 45. Report View Page

4. Choose the report template you want (Cross Sample Peak Table 1 or Cross Sample Peak Table 2) 
from the Template list.

Selected 
Column
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5. Check the correct box for the format you want for your report. The choices are PDF, CSV, Excel, 
or Print. Export as CSV or Excel for import into third-party software packages.

6. Click Generate to generate your report.
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